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1. Welcome

WinTeX 2000 is a text editor which is optimized for use with TeX. WinTeX 2000 offers a variety of functions to
simplify editing of TeX files (e.g. a graphical table editor, toolbars for frequently used TeX-commands and
syntax completion). Syntax highlighting improves the readability of your TeX sources. You can customize
WinTeX 2000 to have every possible TeX-tool just one mouseclick away.

Features include:

• Modern MDI Interface
• Syntax Highlighting with font, color and style
• Graphical user interface to easily manage and edit BiBTeX files.
• Easy management of TeX-Projects with all needed files
• Spellchecking
• Search &amp; Replace
• Nested Undo & Redo
• Unlimited number of connections to external programs
• Buttonbar for easy access of these connections
• Unlimited number of Key-Shortcuts to insert any sequence of TeX-commands on one keystroke or

mouseclick
• Toolboxes for mathematical symbols etc.
• Powerful Table-editor
• Easily find TeX-errors and -warnings.
• One mouseclick lists all \include'd and \input'ed files.
• You can drop bookmarks in the editor and jump back to this line with one keystroke
• Line locator
• Syntax completion

Please also visit the WinTeX 2000 homepage for the most current information:

http://www.tex-tools.de



2. WinTeX 2000 at a Glance

The following chapters will give a brief description of the features of WinTeX 2000. In most cases the
information provided here will be sufficient to help you start with WinTeX 2000 or help you with your
problems. A detailed description of all functions of WinTeX 2000 is given in the next part.

Customising the Editor

You open the properties dialog for the editor by clicking on the entry in the Editor tab of the options dialog. The
details of the properties are discussed in the next part of this document.

Options

The ‘Options’ tab lets you control the behaviour of the editor. You can toggle word wrapping (automated
wrapping of long lines), auto indent (places the cursor under the first non space character in a new line) and
syntax highlighting.

Further you can have a visible right margin atn chracters and a ‘gutter’ which is a blank space at the left hand
side of the editor where special icons give further information on some lines (e.g. bookmarks or wrapped lines).

You can specify by how many characters a block of text is indented if you press <Ctrl>+K I and have a fixed
word wrap column (0 means that the text is wrapped at the width of the window).

For detailed description of all functions see part 3 of this documentation.



Highlighting

On the ‘Highlighting’ tab you can change colours and text styles for special elements of your TeX file. Simply
select an entry in the list (e.g. Comment) and then change the settings for this element. You can see the effect of
your changes in the preview pane.

Key assignments

Here you can change the shortcut keys for some editing functions like ‘copy’, ‘set bookmark’ or even ‘indent
block’, etc.



Auto correct

The auto correct tab lets you specify wrong typed phrases, that should be automatically corrected when typed
(e.g. teh -> the).

Code templates

Code templates provide an easy way to insert often used sequences of TeX commands into the text. If you want
to insert a code template into your text simply type the name of the template and then press the ESC. The cursor
will be placed at the position of the pipe symbol (‘|’) in the template. If you don’t remember the name of the
template you can simply press ESC and WinTeX 2000 will provide a list of all templates to choose from.

Using Templates

In WinTeX 2000 templates provide a convenient way to recycle often used document structures. Simply create
the structure as you need it (e.g. an outline for a letter or for a report) and choose ‘File/Save as template’. The



save dialog will automatically navigate to the templates directory (which is the directory where you installed
WinTeX 2000 + ‘\Template’). Now type a name for your new template and choose ‘Save’. Next time you open
the ‘New file’ dialog from ‘File/New’ you will have an additional entry called like you have specified. Double
clicking this entry will open a new file with the contents of your template.

Using Syntax Completion

Syntax completion is one of the editing aids of WinTeX 2000. It is invoked by the shortcut

<Ctrl>+<Space>.

It completes a TeX command (e.g. \usep -> \usepackage) or a TeX environment (e.g. \begin{environment} is
completed with the corresponding \end{environment}).

If you invoke it on a TeX command WinTeX 2000 provides a list with TeX commands where the cursor is
placed on the best match. You can accept it by pressing <Enter> or scroll through the list and look for a different
entry which is then inserted into the text.

Locating Lines

If you are looking for a specific line in your code either double click on the status bar or right click on the editor
and chose ‘Goto line’.

Spell checking

WinTeX 2000 comes with a built in spell checker. If you have checked the ‘Auto Spell’ option in the ‘Edit’
menu every word that is not found in the defined dictionaries will be underlined. You can then correct this word
by right clicking on it. Additionally you can use the standard spell checking routine which will go through the
text and let you choose a replacement for every word not found in your dictionaries.

Issues concerning special characters and spell checking

In native TeX if you want to have special characters in your text (like ä,â,á, etc.) you have to use special TeX
commands instead. This is a problem when you want to use spell checking because the spell checker does not
recognise these special characters. The solution is to use a TeX style that allows you to use the special characters
in your TeX source. Such a style isinputenc . You can see it in the ‘special characters example’ installed in
your WinTeX 2000 home directory.

Tables in TeX

WinTeX 2000 provides a GUI (graphical user interface) for creating tables in TeX. Creating tables in TeX is a
little bit tricky and if you want your table to look a little bit different than the TeX standard you will have a lot of
work.

The table GUI in WinTeX 2000 lets you paint you table as you know from Excel or Word. You can resize your
cells with the mouse and add or remove every single line in the table. Also you can specify the horizontal and
vertical alignment of every single cell. When you are finished the table will be translated into TeX code and
inserted into your text. Don’t be scared by the strange looking code which is generated. As we said: Creating
custom tables in TeX is a little bit tricky ...

If you want to modify the table later on simply mark the code of the table in your text. The selection must reach
from the comment at the beginning of the table (e.g. ‘% Table generated by WinTeX 2000...’) to the
‘\end{tabular}’ statement. Then press the ‘Create table’ button on the toolbar. Instead of creating a new table
WinTeX 2000 reads in the selected one and displays it in the gui for editing.



Formatting Text

WinTeX 2000 has three buttons on the TeX toolbar that facilitate formatting of text. They are labeled ‘B’, ‘I’ and
‘U’. Simply select the portion of text that should be formatted and press one of the buttons. The selected text will
get surrounded by the corresponding TeX statements. The buttons are:

• ‘B’ – Boldface
• ‘I’ – Italic or Emphasised
• ‘U’ – Underlined

The ‚Strucuture‘ Menu

When you load a TeX file into the editor a new menu item appears labelled ‘Structure’. This menu provides easy
access to certain parts of the TeX source. On the TeX-structure tab in the options dialog you specify a hierarchy
of TeX-commands that mark the beginning of such a part. The hierarchy is preconfigured with the standard
structuring commands of TeX:

\part
\chapter
\section
\subsection
\subsubsection
\paragraph
\subparagraph

According to this hierarchy the TeX file is scanned and the structure menu is generated. By clicking on an item
in this menu WinTeX 2000 jumps to the line where this section starts. This way you have an easy and fast access
to specific parts of your document.

TeX Projects

Large documents should be structured into some smaller files for easier editing and faster access. For example if
a book is split into different parts you could create a separate file for every part. You will then need a ‘frame’
where you put those files together to form your document. It could for example look like this:

%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%
% %
% My Book %
% %
% Title %
% %
% Author %
% Creation date %
% %
%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%

\documentclass[a4paper,12pt,fleqn,openright,titlepage]{book}

\usepackage{latexsym}
\usepackage{epsf}

\bibliographystyle{newapa}

\begin{document}

\tableofcontents

\part{Part I}



\input{part1.tex}

\chapter{Chapter I}
\input{chapter1-1.tex}

\chapter{Chapter II}
\input{chapter1-2.tex}

\part{Part II}
\input{part2.tex}

\chapter{Chapter 1}
\input{chapter2-1.tex}

\end{document}

In WinTeX 2000 you can create a project file where you put all those files together for easier access by choosing
‘Project/New’. On the left hand side of the editor you now see the project pane with one root node. You can add
files to a node in your project by right clicking on the node and choosing ‘Add file’. A new node will be added
as a child node to the selected one and will be labelled with the filename. You can open the file by double
clicking on the node. You can add further children to the new child node and so on. That way the project can get
as nested as you need it.

In your project you will have one main file (as seen above). If you edit for example part II and invoke the TeX
compiler you don’t want it to operate on the file part2.tex but on the main file. Otherwise you will get several
errors because the file part2.tex is not a complete document and is missing some very important TeX commands.
You specify the main file of your project by right clicking on the node and choosing ‘Main file’ from the menu.
The little smiley will become red to indicate the status of this node.

Adding New TeX Programs

Few customisation is needed to use WinTeX 2000 with your local TeX environment. In fact if you use mikTeX
and have the mikTeX binaries directory (e.g. c:\texmf\miktex\bin) in your PATH, WinTeX 2000 comes
preconfigured and you could skip this chapter.

Adding external programs to WinTeX 2000 is done in the TeX-programs tab of the options dialog.



Simply add an entry to the list by clicking on ‘add’ and fill out the properties for the new entry. The properties
are:

• Menu
Specifies the caption that will appear in the TeX menu and on the toolbar.

• Commandline
This is the command that will be executed if this entry is invoked. If you have the program in your PATH
variable you my specify it as shown here, otherwise specify the full pathname (e.g.
‘c:\texmf\miktex\bin\latex.exe %f.tex’). The tag ‘%f’ will be replaced by the current filename (if you use a
TeX project with a main file it will be replaced with the main file instead) and the tag ‘%n’ with the line
number where the cursor was.

• Shortcut
Here you can choose a function key to invoke the command with one keystroke.

• Force execution on current file
If you have checked this box the tag ‘%f’ of the command line will always be replaced with the current file,
no matter if you use a project or not.

• Show button
By unchecking this box you can suppress a button in the toolbar for this entry. An item in the TeX menu
will still be added.

Compiling and Viewing TeX Files

After you have defined your TeX programs in WinTeX 2000 you can use them to compile and view your TeX
file. Simply open the file and then click on the ‘LaTeX’ button on the toolbar or in the TeX menu. You can also
use the shortcut key you have defined for LaTeX (e.g. F5). Now WinTeX 2000 calls LaTeX to compile your file.
You can see how a DOS box is opened and LaTeX does it’s work. If errors occur during compilation you can see
the output in the DOS box and have to react on it (e.g. press ‘q’ to continue compiling in quiet mode (i.e. without
any further error messages) and then use the ‘Errors & Warnings’ dialog (see TeX Errors & Warnings) in
WinTeX 2000 to locate the errors and fix them.

After you have compiled your TeX file you can call the DVI viewer to view the results. Simply click on the
‘DVIWIN’ or ‘YAP’ button on the toolbar.

TeX Errors & Warnings

WinTeX 2000 provides an easy way to work with errors and warnings that come from LaTeX. You can view the
errors and warnings of your last LaTeX run for the current file in the ‘Errors & Warnings’ dialog which can be
accessed over the toolbar or the ‘View’ menu.

The first column shows the file in which the error occurred, the second column shows the error description and
the last column shows the line number in which the error occurred. If you double click on a line the affected file
will be opened in the editor (if it isn’t opened already) and the cursor jumps to the line in which the error
occurred.



The BiBTeX Editor

With the built in editor for BiBTeX databases you can easily manage and edit even large bibliography files. You
can add, edit, delete and even convert entries from one type to another (e.g. UNPUBLISHED -> INBOOK). For
each type and field WinTeX 2000 gives a brief description of it’s purpose.
Each type has an additional editing pane where you can add user defined fields to your entry (e.g. ABSTRACT).
You have to enter these user fields as complete BiBTeX syntax:

ABSTRACT={This book is on TeX}

Inserting Citations

How often did it happen that you wanted to cite an item of your bibliography file and did not remember the key?
With WinTeX 2000 that is no problem any more. Simply press

<Shift>+<ESC>

in the editor. A popup appears with all cite keys of all BIB files that are currently opened by WinTeX 2000.
Simply choose an entry from the list and press <ENTER>. WinTeX 2000 inserts the corresponding
\cite{SOMEKEY} into your text.

Cleaning Up

When you use TeX you will soon end up with a huge number of temporary files that you don’t need any longer.
For example TeX creates

• log files
• auxiliary files
• contents files
• etc.

After you have finished your TeX file these files are no longer needed (since you have the DVI file). If you need
to compile your TeX file again later these files are rebuilt which only takes a little bit longer for the first
compilation run.

WinTeX 2000 can search special parts of your harddisk and delete those files for you. You start this task by
choosing ‘Cleanup’ from the file menu. Which directories are searched and which files are deleted is controlled
via the options dialog.

In the left list you enter the extensions which are to be deleted and in the right list you enter the directories that
are to be cleaned. You can append a ‘//’ to the path to tell WinTeX 2000 to also clean all subdirectories.



3. WinTeX 2000 Reference

This Chapter gives a detailed description of every function of WinTeX 2000.

‚File‘ Menu

New...

This dialog displays all files that reside in the ‘TEMPLATE’ directory under your install directory plus two icons
for an empty document and a BiBTeX file. Choose one with a double click or select an item and then press OK.

Open...

Displays the standard Windows open dialog to open a file.

Reopen

Provides a list of the last 15 files that were edited with WinTeX 2000 with the least recently used one at the
bottom.

Close

Closes the current file. This can also be done by clicking on the small x in the upper right hand corner of
WinTeX 2000 or by pressing <Ctrl>+<F4>.

Save

Saves the current file. If the file has no name yet, the ‘Save as...’ dialog will be displayed to chose a name.

Save all

Saves all open files, in case they are modified.



Save as...

Displays the ‘Save as...’ dialog to choose a new name for the current file.

Save as Template...

Saves the current file as a template. The ‘Save as...’ dialog will be displayed with the templates directory opened.
Simply choose a name for your template and then click OK. The next time you open the ‘File new...’ dialog the
template you just saved will be available.

Cleanup

Starts the cleanup process. All directories specified in the options dialog (see Options/



Cleanup) will be cleaned from all files with an extension listed also in the options dialog.

Import BIB file

If you have a BIB file open you can merge the contents of another one into your current file by choosing this
menu item.

Exit

Exits the program

‚Edit‘ Menu

Undo

Undoes the latest changes step by step. The undo buffer is cleared every time you save your file.

Redo

Redoes undone changes.

Cut

Cuts the selected text to the Windows clipboard.

Copy

Copy’s the selected text to the Windows clipboard.

Paste

Pastes the contents of the Windows clipboard into the text.

Find...

Finds phrases in the current file. In the find dialog you can enter a phrase you want to find. Click Search to find
the next occurrence. You can do a case sensitive or case insensitive search and search for whole words or parts
of words.

After you have found something the ‘Replace’ and ‘Replace all’ buttons become active. You can now type in
text to replace the found text with and click on ‘Replace’ to replace this occurrence and find the next one or
‘Replace all’ to replace all occurrences in the whole file.

Find again

Find again repeats the last find operation with the same settings.

Spellcheck



You can check the spelling of your text with the dictionary you have specified in the options dialog (see
Options/General). WinTeX 2000 searches your text for a word that is not in your dictionary and suggests the
correct spelling.

Auto Spell

If this option is checked WinTeX 2000 will automatically underline every word in your text that is not in your
dictionary.

Thesaurus

The Thesaurus suggests alternatives for the word the cursor is placed in.

Reformat Block

This will remove all hard line breaks from the selected block of text.

‚TeX‘ Menu

This menu displays all TeX programs that you have defined in the options dialog. If you click an item the
corresponding program is executed.

‚View‘ Menu

Log file

A click on this menu item opens the log file that belongs to the current file in the editor.

Errors & Warnings

In the Errors & Warnings dialog you can see a tabular listing of all errors and warnings that occurred during the
last compilation of the current file. In the table you see the filename in which the error occured, the error
description and the line number. A double click on a row in the table takes you directly to the corresponding line
in the file in which the error occurred.



Options

This is the options dialog where you can configure WinTeX 2000. Pressing the default button will cause
WinTeX 2000 to import the default settings for mikTeX. All your settings will be overwritten!

General

In the ‘General’ Tab you have the following options:

Use special BiBTeX viewer
If you uncheck this option WinTeX 2000 uses the standard editor for BiBTeX files instead of the built in
BIB editor.

Show Buttonbar
Unchecking this option will remove the toolbar with the user defined TeX programs.

Auto save editor file
Automatically saves the current file after the specified amount of time.

Create backup copies
When this option is checked WinTeX 2000 creates a copy of the current file with the extension ‘.backup’
before saving it. This way you can recover if you have saved accidentally.

Dictionary
Here you can specify the dictionaries and some options for the spell checking component of WinTeX
2000.

Editor

The editor tab lets you control the behaviour of the editor. You have the following options:

Use key conversion
If this box is checked the table above this option is used to translate keystrokes during editing. This is
mainly useful for accentuated characters (e.g. replace ‘ä’ with ‘”a’).

Show corresponding brace
When you have checked this option WinTeX 2000 jumps to the corresponding opening brace as you type
‘}’. It stays there for the specified amount of time and the returns to the place you entered the closing
brace.

Complete ‘*’ with ‘*’
Here you specify if you want WinTeX 2000 to automatically add the corresponding closing brace as you
type an opening brace.

Editor properties

In this dialog you can change specific options of the editing pane of WinTeX 2000.



Options

The Options tab has quite a lot options to control the general behaviour of the editing pane. The options are:

Word wrap
Toggles automatic word wrap, which means that the line is automatically wrapped if it is to long to
display it in the editing pane or if it has more characters than specified in ‘Word wrap column’.

Auto indent
When checked the cursor is automatically placed below the first non space character when you press
<ENTER>. Only works if word wrap is disabled.

Smart tab
TAB key moves to next non space character in line above. Only works if word wrap is disabled.

Smart fill
If auto indent or smart tab is enabled the occurring space is filled with a minimum number of characters
made up of tabs and spaces. Otherwise the gap is filled with the correct number of spaces.

Use tab character
Insert a tab character into the text if the user presses TAB. Otherwise the correct number of spaces is
inserted instead.

Line numbers in gutter
Display the line numbers in the small panel on the left hand side of the editor.

Mark wrapped lines
Shows an icon in the gutter if the current line is wrapped.

Block cursor for Overwrite
Show a block cursor when the editor is in Overwrite mode (toggled with the INS key).

Word select
Double click selects the whole word.

Syntax highlight
Toggles syntax highlighting.

Show all chars
Also show invisible characters (like tab or linebreak) in the editor.

Visible right margin
Shows a light line at the position specified by the Right margin option. This margin does not affect the



text and is for illustration purposes only. You will only see it if you set the editor background to a colour
other than light grey.

Visible gutter
The gutter is a blank space at the left hand side of the editor where special icons give further information
on some lines (e.g. bookmarks or wrapped lines). You can also specify the width of this area.

Block indent step size
Specifies by how many characters the marked block of text is indented if you press block indent in the
editor (<Ctrl>+K+I).

Word wrap column
Setting this option to zero will cause the text to be wrapped at the width of the display area if word wrap
is enabled. Entering a number here will cause the text to be wrapped at the specified character column.

Show word wrap column
Enabling this option will show a dashed line where the text will be wrapped if the word wrap option is on.
You will only see it if you set the editor background to a colour other than light grey.

Tab columns
Defines tab stops for the editor. The tabs are given as space or comma separated list. The first column of
the display is column one (1). Column values of zero will cause an exception to be generated.

Tab stop
Defines the default tab stop distance when the cursor is beyond the last defined tab column.

Highlighting

This tab lets you define colours to be used for special tags in the text. Choose an item in the list and then define
the attributes with which the text of this type should be displayed. You can see the effects of your changes in the
preview pane in the lower part of the dialog.



Key assignments

Here you can change the key assignments for the different editing functions to meet your needs. You can specify
different keys for one function to use alternatively.

Auto correct

Auto replace definitions are provided to assist in editing by replacing one text item by another. A common use of
auto-replace is to automatically correct common spelling/typing errors such as 'teh' instead of 'the'. Keyboard
shortcuts can also be specified such as (c) to be replaced by the copyright symbol.

Act key(s) describes the keyboard keys that can activate an auto-replace action.



TeX-programs

Here you define the TeX programs that can be used from within WinTeX 2000. Simply press the ‘Add’ button
select the new entry and fill out it’s properties. An entry can be deleted by selecting it in the list and then
pressing DEL.

Menu
The caption that will appear in the TeX menu and on the toolbar.

Commandline
The command which is executed if the user selects the entry in the TeX menu or presses the button on the
toolbar. The command is executed in the directory of the current file. You must either specify complete
pathnames (e.g. "C:\Program Files\miktex\bin\latex.exe") or add the directory with your TeX-tool to the
path variable (This is automatically done if you install mikTeX so you can simply say "latex.exe").

There are two special tags that you can use here. The tag %f will be replaced with the name of the file
which is currently opened by WinTeX 2000 or if you are running a project with the name of the main file
of the project. The %n tag will be replaced with the line number where the cursor is currently located.

Shortcut
Defines a function key that can be used to invoke this command.

Force execution on current file
Forces the execution of this command on the file that is currently opened with WinTeX 2000 rather than
the main file of the project

Show button
Displays a button in the toolbar of WinTeX 2000 for this entry.



Cleanup

This tab lets you specify the parameters for the cleanup process invoked over the file menu. In the left list you
enter the extensions of the files which are to be deleted. In the right list you enter the directories which shall be
searched by WinTeX 2000. Appending a ‘//’ at the end of a path tells WinTeX 2000 to also search all
subdirectories.

TeX-structure

Every file you open with WinTeX 2000 is scanned for it’s internal structure. The information generated is
provided in the structure menu. Here you specify the hierarchy of TeX commands that define the structure of the
file. As default we have the standard TeX commands for structuring TeX files but you can modify the list to
meet your needs.

The very first entry in the list marks the top and the last item marks the lowest level in the structure.



Shortcuts

Code templates are pre-defined snippets of code that are available for insertion into a file being edited. Each
template is defined by a short name, a meaningful description and a replacement specifier. When the short name
is typed at the keyboard and immediately followed by the pressing of the Hotkey (ESC) the short name will be
replaced by the replacement specifier. If the short name is not clear a popup will appear allowing the user to
choose the template he thought of.

Register now

This menu item displays the register now dialog in which you can enter the code you have received from the
author. To register please visithttp://www.tex-tools.de/.

‚Project‘ Menu

This menu controls the TeX projects of WinTeX 2000. Projects provide an easy way to access files that belong
to the same TeX document (e.g. different parts of a document, bibliography files, etc.).

New

Create a new project file. WinTeX projects have the extension *.WPR.

Open

Open an existing project file. You can also open projects via the ‘file’ menu and via the ‘recent files’ menu.

Save

Save the current project. If you choose ‘Save all’ the project will also be saved.

Save as...

Save the current project under a new name.

Close

Close the current project.



Add file...

Add a file to the current project. You can also add files by right clicking on an entry in the project and choosing
‘Add file’ from the context menu. This way you can create hierarchical projects.

Remove file

Remove a file from the current project. The file will not be deleted from your disk but only removed from the
project. This can also be achieved with the context menu of the project.

Main file

Set the main file for the current project. If you execute a TeX command it will not be executed on the current file
but on the main file of the project.

‚Window‘ Menu

With the ‘window’ menu you can control the child windows of WinTeX 2000.

‚Help‘ Menu

Here you can access the online help of WinTeX2000 and LaTeX. In the LaTeX help you can get help on TeX
commands and environments.

‚Structure‘ Menu

When you load a TeX file into the editor a new menu item appears labelled ‘Structure’. This menu provides easy
access to certain parts of the TeX source. On the TeX-structure tab in the options dialog you specify a hierarchy
of TeX-commands that mark the beginning of such a part. The hierarchy is preconfigured with the standard
structuring commands of TeX:

\part
\chapter
\section
\subsection
\subsubsection
\paragraph
\subparagraph

According to this hierarchy the TeX file is scanned and the structure menu is generated. By clicking on an item
in this menu WinTeX 2000 jumps to the line where this section starts. This way you have an easy and fast access
to specific parts of your document.


